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About Me

Curriculum Vit
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1999: Maitrise (informatics) at Université de Saint Etienne

2003: PhD (informatics) at ENS-Lyon

2004: Post-Doctoral Researcher at University of California, Santa Barbara.
2004: Temporary teaching assistant at Université de Grenoble.

Since 2005: Assistant professor at Université de Lorraine / Telecom Nancy
2011 - 2013: On leave at Inria Nancy — Grand Est

March 2013: Habilitation Thesis

2013 — 2014: Leader of the Algorille joint team (Algorithms for the Grid)
2015 —: Member of the VeriDis joint team (Verification of Distributed Systems)
Future? Professor in ENS-Rennes (team Myriads) ?

Research Common Theme since 15 years

| 4

>

>

Discovery and Modeling of Large-scale HPC Systems (since my M.S work!)
Make them usable by others: e.g., provide performance models to schedulers
One of the main contributors to SimGrid, a scientific instrument for such studies
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Modern Computers are Large and Complex

Massive Parallelism

Tianhe-2 (China) 3,120,000 cores 18MW
Titan (USA) 560,640 cores  8MW
Sequoia (USA) 1,572,864 cores MW
K Computer (Japan) 705,024 cores 13MW
Mira (USA) 786,432 cores  4MW

G

Computational Science ~» ExaScale Systems
» Huge impact in all sciences and techniques and industries and businesses

» 1 Exaflop = 10'8 operations. One million million million operations. ..

Not only in Computational Science

» Google dissipates 300MW ; Botnets control millions of zombie computers

» In addition, these systems are heterogeneous and dynamic

So, how do we study these beasts?
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Computational Science of Computer Systems

My Research Field: Methodologies of Experimentation
» Goal: assess the performance and correctness of large-scale computer systems
» Question: Are we really producing scientifically sound results?
» Main contribution: SimGrid, a simulator of large-scale computer system

My approach: | am a physicist
» Empirically consider large-scale computer systems as natural objects
» Eminently artificial artifacts, but complexity reaches “natural” levels
» Other sciences routinely use computers to understand complex systems

........

[PPL’OQ], cited 52 times.
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Simulating Distributed Systems

Simulation: Fastest Path from Idea to Data
> Get preliminary results from partial implementations
» Experimental campaign with thousands of runs within the week
> Test your scientific idea, don't fiddle with technical subtleties (yet)

Slmulatlon P
Models olLaEr 8

Idea or Experimental Scwentmc Resu\ts
MPI code Setup
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Simulation: Fastest Path from Idea to Data
> Get preliminary results from partial implementations
» Experimental campaign with thousands of runs within the week
> Test your scientific idea, don't fiddle with technical subtleties (yet)
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MPI code Setup

Simulation: Easiest Way to Study Distributed Applications
» Everything is actually centralized: Partially mock parts of your protocol

> No heisenbug: (Simulated) time does not change when you capture more data
» Clairevoyance: Observe every bits of your application and platform

High Reproducibility: No or very few variability

Capacity planning: What if network or CPU were faster

vV vV

Don't waste resources to debug and test
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Simulation Challenges

=]
Simulation?’|:
+ p AN e )
/. Models -f+%""

&
Idea or Experimental Scientific Res-ults\
MPI code Setup

Challenges for the Tool Makers

> Validity: Get realistic results (controlled experimental bias)
> Scalability: Fast enough and Big enough

» Open Science: Integrated lab notes, runner, post-processing (data provenance)
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Simulation of Parallel/Distributed Systems

Network Protocols: Standards emerged: GTNetS, DaSSF, OmNet++, NS3
Huge amount of non-standard tools in other domains:

» Grid Computing ‘OptorSimHChicagoSim‘ GridSim || JFreeSim | . ..

» Peer-to-peer [ P2Psim || SimP2P || PeerSim | [ OverSim | ...
» Volunteer Computing [ simBA |[ EmBOINC |[ simBOINC] ...
» HPC/MPI Dimemas M’ BigSim H LogGoPSim HM@I .
» Cloud Computing [ CloudSim || GroudSim | [iCanCloud | [ GreenCloud | ...

This raises severe methodological /reproducibility issues:
> Short-lived, badly supported (software QA), sparse validity assessment
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Simulation of Parallel/Distributed Systems

Network Protocols: Standards emerged: GTNetS, DaSSF, OmNet++, NS3
Huge amount of non-standard tools in other domains:

» Grid Computing ‘OptorSimHChicagoSim‘ GridSim || JFreeSim | . ..

» Peer-to-peer [ P2Psim || SimP2P || PeerSim | [ OverSim | ...
» Volunteer Computing [ simBA |[ EmBOINC |[ simBOINC] ...
» HPC/MPI Dimemas M’ BigSim H LogGoPSim HMM .
» Cloud Computing [ CloudSim || GroudSim | [iCanCloud | [ GreenCloud | ...

This raises severe methodological /reproducibility issues:
> Short-lived, badly supported (software QA), sparse validity assessment

SimGrid: a 15 years old joint project r(glM/
» Versatile: Grid, P2P, Clouds, HPC, Volunteer )
> Collaborative: (ANR, CNRS, Univ., Inria) Open Source: active community
» Widely used: 150 publications by 120 individuals, 30 contributors

http://simgrid.org/ [UKSim'08] cited 350, [JPDC'14]

,\‘
J
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SimGrid Key Features: Fluid Network Model

> Packet level models: Full net stack. Inherently slow, hard to instantiate

» Simple models: Delay-based, distribution, coordinates
Very scalable, but no topology, no network congestion
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SimGrid Key Features: Fluid Network Model

> Packet level models: Full net stack. Inherently slow, hard to instantiate

» Simple models: Delay-based, distribution, coordinates
Very scalable, but no topology, no network congestion

» Fluid models: Share bandwidth between flows on macroscopic evts

Bandwidth sharing as an optimization problem

Z pi <G

if flow i uses link j

» Max-Min objective function: max (min (p;))

» Reno fairness: max (Z arctan (p,-))

> Vegas fairness: max (Z log (p,-))
We implement, (in)validate and optimize these models since 10 years

» The classical "Observe, Analyze, Hypothesis, Test" loop

8/20
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Validity Success Stories

unmodified NAS CG on a TCP/Ethernet cluster (Grid'5000)
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Key aspects to obtain this result

v

vV v Vv

Network Topology: Contention (large msg) and Synchronization (small msg)
Applicative (collective) operations (stolen from real implementations)
Instantiate Platform models (matching effects, not docs)

All included in SimGrid but the instantiation (remains manual for now)

[IPDPS'11] cited 35, [SC'13]
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Validity Success Stories

unmodified NAS CG on a TCP/Ethernet cluster (Grid'5000)
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Discrepency between Simulation and Real Experiment. Why?
» Massive switch packet drops lead to 200ms timeouts in TCP!
» Tightly coupled: the whole application hangs until timeout
> Noise easy to model in the simulator, but useless for that very study
» Our prediction performance is more interesting to detect the real issue

[IPDPS'11] cited 35, [SC'13]
T9/20 0
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Agenda

@ Parallel Simulation of Discrete Event Systems

I Sci of C S Introduction CS® Models PDES Formal CC T9/20 >




Parallel Simulation of Discrete Event Systems

Classical Parallel Schema: split the whole applicative model

1
Sy

> Leads to good speedups (but still poor performance)
dPeerSim: 4h — 1h when 2 LPs — 16 LPs (but 50s in sequential PeerSim)
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Parallel Simulation of Discrete Event Systems

Classical Parallel Schema: split the whole applicative model

> Leads to good speedups (but still poor performance)

dPeerSim: 4h — 1h when 2 LPs — 16 LPs (but 50s in sequential PeerSim)

New approach: Split at Virtualization layer (not in simulation engine)

User Code

Virtualization Layer

Workload

Networking Models

Simulation Engine

» Virtualization contains threads (user’s stack) c
. . . (=}
> Engine & Models remains sequential E
> — g
tn : 1__‘tn+1 1_‘tn+2
| u u

Execution
Environment

» Synchronization costs of paramount importance
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Efficient Parallel Fine-Grained Simulation

SimGrid is an Operating System
Simcalls separate processes, alleviating locking issues

> Very similar to syscalls in an operating system

Functional View Temporal V|ew
[roces] [poces] [rocess] ) .
Process | [Process | | Process H :

. U, <i|—+3 : i

SimCall Interface U, H :
TEJ Maestro M-8 : Mee
(| Simulation Models

simcall B Models+Engines
requestis 4@ answer B Virtualization + Synchro
2 (i
actual interaction B User (isolated)
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Efficient Parallel Fine-Grained Simulation

SimGrid is an Operating System

Simcalls separate processes, alleviating locking issues

> Very similar to syscalls in an operating system

Functional View Temporal View

lProcessI IProcessI lProcessI U2 -
SimCall Interface U H H H :

— 1 R E—— A :

g Maestro M--& : : BEE : YRR

g? Simulation Models

simcall B Models+Engines
request2 <@ answer

zation + Synchro
= r (isolate
actual interaction User (isolated)

Leveraging Multicores

= More processes than cores ~» Worker Threads (that execute co-routines ;)

SS55566SS Processes 666559 T T, opoporo————po—-

Worker ‘ ‘ Worker‘ ‘ Worker { B i : o fetch_add()
'z Maestro T [ _,——-"’_’ Tz : ® futex_wait()
5 Simulation Models L ,»_» Ly T, —ﬁé)—bo—bo—»o. wfutex_wake()
Functional View Temporal View Ideal Algorithm
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Performance Results

» Scenario: Initialize Chord, and simulate 1000 seconds of protocol
> Arbitrary Time Limit: 12 hours (kill simulation afterward)

40000 - nLargest simulated scenario
OverSim (OMNeT++) —@—
. PeerSim —5— Size | Time
OverSim (simple underlay) —e— |
I SimGrid (sequential) —»— | Omnet-|——|— 10k 1h40
30000 1 SimGrid (4 threads) - > - i PeerSim ].OOk 4h36
£ I OverSim | 300k | 10h
5 i 10k | 32s
2 20000 SimGrid, seq | 300k | 32mn
I 2M | 6h18
£ 10k | 130s
10000 SimGrid// | 300k | 40mn
i 2M 5h55
. 1 1 1 .JMemory Usage

0 500000 1e+06 15406 2e+06 18kiB /process (stack: 12kiB)
Number of nodes

First time that PDES is (a little) faster than DES  [CCGrid'12], cited 17

I Sci of Comp Sy Introduction CS2 Models PDES Formal CC 12/20



Agenda

@ Dynamic Verification of Distributed Applications
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Assessing the Correctness of HPC codes?

Writing Distributed Apps is notoriously difficult, but

The Good Old Days

» MPI codes circumvented issues with rigid communication patterns

2

» Performance First: fast code that rarely fail-stop > correct slow code

These Days are Now Over

» But rigid patterns do not scale! We now have to release the grip
> But this is dangerous! We now have to explicitly seek for correctness

Slowly, old ignored problems resurface

> When Tests are not enough anymore, turn to Formal Methods

I Sci of C Sy Introduction CS2 Models PDES Formal CC
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Model Checking and Dynamic Verification

Automated Formal Methods
» Try to assess the correctness of a system by actively searching for faults
» If no fault found after an exhaustive search, correctness experimentally proved

» Dynamic Verification: Model Checking applied to real applications

Exhaustive Exploration
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Model Checking and Dynamic Verification

Automated Formal Methods
» Try to assess the correctness of a system by actively searching for faults
» If no fault found after an exhaustive search, correctness experimentally proved

» Dynamic Verification: Model Checking applied to real applications

Exhaustive Exploration Model Checking: the Big Idea

Property (safety or liveness)

System model
Model checker

/Property satisfied | [Property not satisfied] [ Fail (out of memory, out of time, ...)

[ et snete]

Counter-example

» My preferred outcome: a counter-example
» | tend to bug finding, not certification
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SimGridMC: Formal Methods in SimGrid

Verify any application that would run in SimGrid

» Reuse the simulator's light virtualization to mediate apps’ actions

» Replace the simulation kernel underneath with a model checker

» Tests all causally possible orders of events to dynamically verify the app
» System-level checkpoints the app to then rewind and explore another path
> This works with SMPI, and MSG (our simple API to study CSP algorithms)

User Code

H SMPI

processes

Synchro,
abstractions

uuuuuuuuuu

{

oo

—_

D(n, nnn ——

A Yal

g

Platform

Description
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Example: Out of order receive

» Two processes send a message to a third one
> The receiver expects the message to be in order
» This may happen. . .or not

send(1) send(1)

rank; @q——————  [if (PI_rank() == 0) { ranki X ——————
MPI_Recv(&x , MPI_ANY_SOURCE);

P send(2) MPI_Recv(&y , MPI_ANY_SOURCE); k send(2)

ranks " MC_assert(x < y); ranka
\X <y } else { \ X §< y
ranko TP . MPI_Send (&rank , 0); rankoi —O-@—
x+1ly<«+2 x2y<«1

skokskok ok sk ok ok sk ok ok ok ok ok sk ok sk ok ok ok ok ok

*%* PROPERTY NOT VALID *#*

sokskok ok ko sk ok ok sk ok sk ok skskok ok ko ok

Counter-example execution trace:

[(1)recver] iRecv (dst=recver, buff=(verbose only), size=(verbose only))
[(3)sender] iSend (src=sender, buff=(verbose only), size=(verbose only))
[(1)recver] Wait (comm=(verbose only) [(3)sender -> (1)recver])
[(1)recver] iRecv (dst=recver, buff=(verbose only), size=(verbose only))
[(2)sender] iSend (src=sender, buff=(verbose only), size=(verbose only))
[(1)recver] Wait (comm=(verbose only) [(2)sender -> (1)recver])
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Mitigating the State Space Explosion
Many execution paths are redundant ~ cut exploration when possible

Dynamic Partial Ordering Reduction (DPOR)

» Works on histories: test only one transitions' interleaving if independent

» Independence theorems: Local events are independent; iSend+iRecv also; . ..
» Must be conservative (exploration soundness at risk!)
> It works well (for safety properties)

System-Level State Equality

> Works on states: detect when a given space was previously explored
» Complementary to DPOR (but not compatible yet)
> Introspect the C/C++/Fortran app just like gdb (+some black magic)

Kernel space

| Stack S v

Anonymous mappin
Dynanmic libraries e ®
b 55
a ) Dats pra—
internal data
B Te

BSS segment

Data segment »
[AVOCS y 1 0] tb ta Text segment —  Dynamic system state [P D P ) 1 5]

C I Sci of Comp Sy Introduction CS2 Models PDES Formal CC 17/20




Some Results

Wild safety bug in our Chord implementation (= 500 lines of C)
» Simulation: bug on large instances only; MC finds small trace (1s with DPOR)

Mocked liveness bug

> Buggy centralized mutual exclusion: last client never obtains the CS
» About 100 lines — state snapshot size: 5Mib; Verified with up to 7 processes

Verifying MPICH3 complience tests
» Looking for assertion failures, deadlocks and non-progressive cycles

> 6 tests; =~ 1300 LOCs (per test) — State snapshot size: =~ 4MB

> We verified several MPI2 collectives too @ (but all good so far ®)

Protocol-wide Properties

> e.g, Send-deteministic: On each node, send and recv evts always in same order
(allows more efficient application checkpointing)

> Even harder than liveness properties (not LTL), but doable in SimGrid
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Much more to say about SimGrid (too little time)

Hybrid Network Models

» Fluid model: model contention in steady state for large messages
» LogOP model: model intra-node delays and synchronization

> Also: MPI collectives, TCP (slow-start, cross-traffic), soon IB

Realistic Emulation
» SMPI: Study real MPI applications within SimGrid

> Simterpose: Study real arbitrary applications (ongoing)

High Performance Simulation
» Fast Enough: Innovative PDES; Efficient algorithms and implementations

» Big Enough: Scalable and versatile platform representation

Formal Verification of Distributed Apps
» Safety, Liveness or CTL properties, with DPOR or state equality
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Research Project for the Next 10 Years

Make Large-Scale Distributed Systems Easier to Use

» They are pervasive in our connected societies, yet almost uncontrolled
» Research Plan: Computational Science of Computer Systems
> Leveraging computers to understand computers

» Expected Visible Outcome: Propose a valgrind-like for Distributed Systems
> This is perfectly in line with what I'm doing since 15 years

Why in Myriads?

» Distributed Systems, with focus on experimentation (Grid'5000, etc)
» Many works that solve hard OS-level issues to help distributed systems

Why at ENS Rennes?
» We need more teachers that are proficient with Systems Internals

» Teaching of paramount importance to me. Lots of activities on teaching CS:
» Unplugged activities; Programming exercisers; Research groups; National Days
» More on this on Friday 12:30 :)
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What is SMPI?

» Reimplementation of MPI on top of SimGrid

» Imagine a VM running real MPI applications on
platforms that does not exist

» Horrible over-simplification, but you get the idea

» Computations run for real on your laptop,
Communications are faked

What is it good for?

» Performance Prediction (“what-if?" scenarios)
> Platform dimensioning; Apps' parameter tuning

» Teaching parallel programming and HPC

> Reduced technical burden
> No need for real hardware, or hack your hardware

Studies that you should NOT attempt with SMPI

» Predict the impact of L2 caches’ size on your code
» Interactions of TCP Reno vs. TCP Vegas vs. UDP

» Claiming a simulation of 1000 billions nodes
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SimGrid Network Model

Measurements — ‘
weRegec weBERged
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ﬁ
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SimGrid Modeling of MPI
MPI Collectives

» SimGrid implements more than 120 algorithms for the 10 main MPI collectives

» Selection logic from OpenMPI,MPICH can be rproduced

HPC Topologies

Torus Fat-trees Hierarchies of ASes
But also
» External load (availability changes), Host and link failures, Energy (DVFS)

» Virtual Machines, that can be migrated; Random platform generators
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SimTerpose Project

Dream: Simulate any applications on top of SimGrid

Simulated Setup Take 1: ptrace plumbering

-l 10042 ]. Real Port

@accept(10042)“x’ @;connect(host,loodz)

[o ]

- i: --- -- 777777 SimTerpOSé 777777 L
o -

o P

(Daccept(80)

uod

(22

(3 connect(A,80)

Host A Host B Hosting Computer

Take 2: Full Emulation Current State

» Functional POC: send/recv exchange

> Need to handle the other 200 syscalls

ptrpce intercept

Srectimemoly : :n:ercepF, store metadata
% . % " access % nform simulator, report effect on procs
Threads'rlsrrl;v\;‘l[;nulator » Time and DNS need love at link time
o) » We are redeveloping a libC! (in strange way ;)
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